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This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FULL CIRCLE.

A

s ever, we have Python, Freeplane, Inkscape, but, unfortunately, no Great Cow Basic for you
this month. Replacing Great Cow Basic for this month we have an article on encrypting your
data with Cryptomator. Always better safe than sorry.
As you may remember, from last month, Gord is unable to continue with his regular Q&A
column. EriktheUnready (Telegram group mod extraordinaire) has stepped up and is going to give
Q&A a try. So, round of applause for Erik. Q&A is probably one of the most popular parts of FCM.
No pressure, Erik.
We have a special news report about UBports (formerly Ubuntu) Touch. They've set the wheels
in motion for the future by setting up a foundation. That future also holds an update from the old
1 4.x Touch to the new 1 5.x Touch that they've been working on. This brings big changes, and has
been a long time coming. They're also implementing Android compatibility. This means your
UBports Touch device will be able to run Android apps. This is big. No, BIG . As missing some apps
is what often stops people adopting Touch. Now, there's no excuse. You really can have the best
of both worlds with Touch.

All the best, and keep in touch!
Ronnie

Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
http://issuu.com/fullcircle
magazine
http://www.magzter.com/
publishers/Full-Circle

Weekly News:

ronnie@fullcirclemagazine.org

http://fullcirclemagazine.org/f
eed/podcast
http://www.stitcher.com/s?fi
d=85347&refid=stpr
http://tunein.com/radio/FullCircle-Weekly-News-p855064/
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Submitted by Arnfried Walbrecht

SUSE LINUX SOLD FOR
$2.535 BILLION

FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8

B

ritish firm Micro Focus
International is selling its open
source SUSE software to the
Swedish group EQT Partners. The
$2.535 billion deal boosted shares
by 6 percent.

revenue of $303 million and
adjusted operating profit of $98.7
million in the year ending April
201 7.

changes to data structures relative
to relational databases. They are
thus better suited to the
requirements of high-traffic web
services, which should always be
Source:
available. This is also the basis for
https://betanews.com/201 8/07/03/ the success of MongoDB, which
suse-linux-sold/
enjoys some popularity.

MongoDB 4.0 extends the
database
with transactions, type
M ONGODB 4.0 RELEASED conversions,
SUSE Linux has been in the
and Kubernetes
hands of Micro Focus International
integration. The ability to transact
ongoDB is one of the sosince 201 4 and it has been running
called NoSQL databases (Not makes it possible for the first time
it as a largely independent division,
to change several documents in a
competing directly with the likes of only SQL), which in favor of
performance on some properties of consistent manner at the same
Ubuntu and Red Hat. The
time and to ensure that either all
acquisition by EQT Partners means relational database systems, e.g.
documents in the changed form
Schema, locking mechanisms or
that more developers and
have been taken over permanently
engineers will be hired to work on dynamic queries, renounce. The
or none. This warranty also covers
schema-free MongoDB stores the
the product.
the replicas of the database
SUSE is the operating system of data in BSON (binary JSON)
instance.
structures, supports replication,
choice for many enterprise
and lends itself well to large
operations, as well as banks and
Source: https://www.progovernments. The new owners feel objects such as video or large
linux.de/news/1 /26055/mongodbthat an injection of cash, as well as images. It is mostly implemented in 40-erschienen.html
not being based in the US, will very C ++ and distributed under the
Apache License 2.0 or the Affero
much work in SUSE's favor….
General Public License (AGPL) 1 .0.
ELEMENTARY OS 5.0 B ETA
Micro Focus says the price paid
NoSQL databases promise much AND CENTOS 6.1 0 ARE
by EQT is "highly attractive",
faster setup, better scalability,
revealing that SUSE generated
H ERE
easier replication, and faster
full circle magazine #1 35
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A

fter much wait and
anticipation, the elementary
OS developers have shipped the
first beta of their forthcoming
“Juno” release. Being called a
Developer Preview, it is aimed at
the 3rd party developer and other
users who are interested in testing
the new features.
This release cycle will primarily
strive to deliver a better
experience by incorporating
different design and UX
improvements. The designers have
worked hard on the icons and
modified about 1 000 icon files.
There has also been a jump from
Gtk+ 3.1 8 to Gtk+ 3.22, resulting in
a full rewrite of stylesheets.
Ementary OS 5.0 has been
updated with a new set of default
wallpapers, new sound effects,
night light feature, and better
installation procedure. There are
tons of other under-the-hood
changes and bug fixes as well.
Derived from the RHEL sources
made freely available by Red Hat,
CentOS is known for its ability to
serve as a server machine as well
as a daily driver.
The latest CentOS 6.1 0 release

comes loaded with many changes
as compared to CentOS 6. All the
updates since upstream 6.1 0
release have also been made
available on CentOS mirrors.

In the more narrow view of
actual executables, Java-based
malware such as McRAT has
proliferated in the past, though
Java on the desktop is practically
unheard of on consumer
Source:
computers in 201 8. Likewise, with
https://fossbytes.com/centos-6-1 0- enterprises moving away from
elementary-os-juno-beta-released/ installing Java SE on workstations,
the viability of that approach has
dwindled. However, Google's
supports cross
THIS NEW DUAL-PLATFORM Golang—which
compiling to run on multiple
MALWARE TARGETS BOTH
operating systems—is now being
utilized by attackers to target
WINDOWS AND LINUX
Windows and Linux workstations.
SYSTEMS
According a report by JPCERT,
ne of the oft-repeated
the
WellMess malware can operate
reasons for using alternative
on WinPE (Windows Preinstallation
operating systems is the
Environment) and on Linux via ELF
suggestion that alternatives to
Windows are more secure because (Executable and Linkable Format).
malware is not produced for these The malware gives a remote
attacker the ability to execute
minority systems—in effect, an
arbitrary commands as well as
argument in favor of security by
upload and download files, or run
minority. For a variety of reasons,
PowerShell scripts to automate
this is a misguided notion. The
tasks. The commands are
proliferation of web-based
transferred to the infected device
attacks—which are inherently
cross-platform, as they depend on via RC6 encrypted HTTP POST
browsers more than the underlying requests, with the results of
executed commands transmitted
OS the browser runs on—makes
to the C&C server via cookies.
this argument rather toothless.

O
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Source:
https://www.techrepublic.com/arti
cle/this-new-dual-platformmalware-targets-both-windowsand-linux-systems/

U BUNTU BUG ALLOWS

ANYONE WITH PHYSICAL
ACCESS TO BYPASS YOUR
LOCK SCREEN

A

bug filed on Ubuntu
Launchpad in the middle of
June has just been made public.
The bug in question appears to
allow anyone with physical access
to the computer to bypass the lock
screen by just removing the hard
drive. The bug was tested on
Ubuntu 1 6.04.4 and it’s unclear
whether it affects other versions
of Ubuntu or other distributions
but there’s an almost certain
chance it affects other
distributions based on Ubuntu
1 6.04, such as Linux Mint 1 8.
The attack works in the
following way, a user boots into
Linux and opens up their programs
and files, then the machine is
suspended and it goes into low
power mode and writes the state
contents ^
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of the machine to memory. At this
point an attacker can remove the
hard drive and wake up the system;
now they’ll either see the lock
screen and be able to enter any
password to gain access. They
might try the password and be
denied access at which point they
can fast press the hardware shut
down button and gain access, or no
lock screen will appear but instead
the screen will be black and the
previous steps can be attempted.

threat over the weekend. Code in
the acroread package. An attentive
user had reported the package.
What the creator meant, one can
only guess.

The compromised packet that
had previously been orphaned for
a while had been taken over by a
user with the nickname "xeactor".
He had inserted a script that
creates a systemd service that
collects technical data about the
affected system and sends it to a
Source:
pastebin. However, "xeactor" made
https://www.neowin.net/news/ubu a mistake because his script did not
ntu-bug-allows-anyone-withwork as expected. Two more
physical-access-to-bypass-yourpackages were compromised in the
lock-screen
same way. All affected packages
are now removed and "xeactor"
locked out.

M ALWARE FOUND IN ARCH
USER REPOSITORY AUR

Source: http://www.prolinux.de/news/1 /26074/malwareim-arch-user-repository-aurrch warns on its website: "AUR gefunden.html
packages are custom content.
The use of the provided files is at
your own risk”. That the warning
should be taken seriously and the M INIMAL U BUNTU FOR
PKGBUILD files in the AUR, the
CONTAINERS AND CLOUDS
arch repository with user-created
and maintained packages, should
y default, Linux comes with a
always be checked prior to
lot of extras. Usually, that's a
installation, unless the creator is
good thing. But, sometimes you
trusted, proved to be a malware
want just the bare necessities of
full circle magazine #1 35
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Linux life for your server,
containers, and clouds. That's
where Canonical's latest Ubuntu
release, Minimal Ubuntu, comes in.
When Canonical says "Minimal",
they mean minimal. Weighing in at
a mere 29MB for the Ubuntu 1 8.04
Docker image, Minimal Ubuntu
could fit on a CD with hundreds of
Megabytes to spare.
This is far from the first time
Canonical has offered a smallfootprint Ubuntu. The minimal
Ubuntu ISO image, about 40 MB, is
meant for people who download
packages from online archives at
installation time.
While that release is useful
mostly for hobbyists, Minimal
Ubuntu 1 8.04 Long Term Support
(LTS) serves as an efficient
container operating system. It
enables developers to deploy and
boot multi-cloud containerized
applications faster. The minimal
Ubuntu image is already being
used as the standard Docker Hub
Ubuntu 1 8.04 LTS image.
As Paul Nash, the Google Cloud
Group Product Manager, said in a
statement, "The small footprint of
Minimal Ubuntu, when deployed

6

with fast VM provisioning from
GCE, helps deliver drastically
improved boot times, making them
a great choice for developers
looking to build their applications
on Google Cloud Platform."
It's not just true on Google
Cloud. These advantages work on
any cloud. It's available on Amazon
EC2, Google Compute Engine
(GCE), LXD, and KVM/OpenStack.
Source:
https://www.zdnet.com/article/mi
nimal-ubuntu-for-containers-andclouds/

D EBIAN 'STRETCH ' 9.5
LINUX DISTRIBUTION

AVAILABLE FOR DOWNLOAD

D

ebian 9 "Stretch" was
released over a year ago -time really flies! Since then, the
wildly popular Linux distribution
has been downloaded by countless
users.
Today, the 5th "point" release
becomes available. In other words,
Debian Linux "Stetch" has reached
an important milestone -- version
9.5 stable. The operating system is
contents ^
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always improving with security
updates and bug fixes, and 9.5 is
no exception here. In fact, it
includes a patch for Spectre V2.
Also of significance, the Debian
Installer has been given an update.

As the company is reaching
It is expected that the Atari VCS
closer to the development process, will be ready to ship by July 201 9.
the new announcement has further
boosted the hopes of gaming
Source:
enthusiasts.
https://fossbytes.com/atari-vcsram-atarios-linux-distro/
Speaking
of
controllers,
Atari
ATARI VCS RAM D OUBLED Classic Joystick and the Atari
"The Debian project is pleased
to announce the fifth update of its TO 8GB; WILL S HIP WITH
Modern Controller are the
RED H AT ENTERPRISE LINUX
stable distribution Debian 9
standard input devices.
LINUX-BASED D ISTRO
6 & CENTOS 6 PATCHED
(codename 'Stretch'). This point
Additionally, AtariOS, the custom
“A
TARI
OS”
release mainly adds corrections for
Linux-based OS, will have a
AGAINST SPECTRE V4, LAZY
security issues, along with a few
FPU FLAWS
fter organizing the Atari VCS standardized controller support
adjustments for serious problems.
with a built-in controller
crowdfunding campaign to
Security advisories have already
remapping tool which will allow
sers of the Red Hat Enterprise
collect money and creating the
been published separately and are hype for the upcoming Atari VCS
users to remap physical controller
Linux 6 and CentOS Linux 6
referenced where available," says console, the console has received a buttons to logical standardized
operating system series received
The Debian Project.
buttons.
important kernel security updates
major update in the hardware.
that patch some recently
The project further says,
Explaining
the
details
of
discovered vulnerabilities.
As compared to the previously
"Please note that the point release announced 4GB RAM which
AtariOS, he said, “Our core
does not constitute a new version somewhat made it look like any
architecture consists of the Atari
Now that Red Hat Enterprise
of Debian 9 but only updates some other console out there, Atari VCS Secure Hypervisor and a heavily
Linux 7 and CentOS Linux 7
of the packages included. There is project’s System Architect Rob
modified Linux kernel called the
operating system series were
no need to throw away old
AtariOS.
All
of
this
is
in
flash
patched against the Spectre
Wyatt announced that the console
'stretch' media. After installation,
memory, and before the AtariOS
Variant 4 (CVE-201 8-3639) security
will now ship with 8GB of DDR4
packages can be upgraded to the
loads,
any
external
storage
device
vulnerability, as well as the Lazy
RAM.
current versions using an up-tois checked, and if a bootable device FPU State Save/Restore CPU flaw,
date Debian mirror. Those who
it's time for Red Hat Enterprise
In a Q&A blog post on Medium, is found, the OtherOS on that
frequently install updates from
Linux 6 and CentOS Linux 6 to
Rob who is also one of the leading device is loaded instead.”
security.debian.org won't have to
receive these important security
men behind the original Xbox
update many packages, and most
This
separation
of
AtariOS
and
updates, which users can now
System, announced the memory
such updates are included in the
OtherOS
will
result
in
denied
install them on their computers.
boost along with some other
point release."
access to Atari services when the
insights of the console.
OtherOS is running.
As expected, the most
Source:
https://betanews.com/201 8/07/1 4
/debian-linux-stretch-95download/

A

U
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important fix is that for Spectre
Variant 4, an industry-wide CPU
flaw that affects numerous
modern microprocessor using a
common performance
optimization known as speculative
execution of Load & Store
instructions, which could allow an
unprivileged attacker to read
privileged memory via targeted
cache side-channel attacks.
Patches are now available for Intel
x86 and AMD CPUs.

soon as possible, and CentOS Linux
6 users should update their
systems as well to kernel-2.6.32754.2.1 .el6.i686.rpm on 32-bit and
kernel-2.6.32754.2.1 .el6.x86_64.rpm on 64-bit.

The Lazy FPU state save/restore
CPU flaw (CVE-201 8-3665) was
patched as well in this latest kernel
security update to the Red Hat
Enterprise Linux 6 and CentOS
Linux 6 operating system series,
which could lead to leakage of FPU
state information. Additionally, the
new kernel updates also address a
use-after-free vulnerability in the
mm/mempolicy.c:do_get_mempoli
cy function (CVE-201 8-1 0675),
which could lead to local denial of
service attacks.

SLACKWARE, THE O LDEST
ACTIVE LINUX D ISTRO,
TURNS 25

Also fixed is a kernel error in
exception handling (CVE-201 88897 regression and CVE-201 81 0872), which could also lead to
denial of service attacks. Red Hat
Enterprise Linux 6 users are urged
to update their installations as

Source:
https://news.softpedia.com/news/
red-hat-enterprise-linux-6-centos6-patched-against-spectre-v4-lazyfpu-flaws-521 965.shtml

O

For many Linux enthusiasts, it
turned out to be the starting point
of their Linux journey. Due to its
vanilla experience and minimum
customization offerings, it slowly
developed a cult following. The
project’s website calls it an effort
to produce the most UNIX-like
distribution with “the twin goals of
ease of use and stability as top
priorities.”
Today, Slackware has witnessed
more than 30 versions and it
remains an active distribution. The
latest release was shipped in 201 6
as Slackware 1 4.2; it offered Xfce
and KDE as the two choices for the
desktop environment.

n July 1 6th, 1 993, Slackware
Linux distribution was
Source:
officially released. Based entirely
https://fossbytes.com/slackwareon the Softlanding Linux System
birthday-25-oldest-active-linux(SLS) system, it was designed for
distro/
the machines with a 3.5” boot
floppy. Over the past 25 years,
Slackware has turned out to be one
PINGUY OS PUTS O N A
of the most influential Linux
distros around.
H APPIER GNOME 3 FACE

P

The very first releases of SUSE
inguy OS 1 8.04 is an UbuntuLinux and other open source
based distribution that offers
pioneers were based on Slackware; a non-standard GNOME desktop
its effect is also seen on other
environment intended to be
operating systems with “do it
friendlier for new Linux users.
yourself” motto.
full circle magazine #1 35
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This distro is a solid Linux OS
with a focus on simple and
straightforward usability for the
non-geek desktop user. If you do
not like tinkering with settings or
having numerous power-grabbing
fancy screen animations, Pinguy
OS could be a good choice.
The GNOME desktop is the only
user interface option, but Pinguy
OS' developer, Antoni Norman,
tweaked the desktop environment
with some different software
options not usually packaged with
GNOME.
His refusal to settle for the runof-the-mill software typical of
mainstream GNOME choices is one
of this distro's strongest features.
The developer gives you better
application options to create the
best user experience within the
modified GNOME environment.
Pinguy OS is a great pick for
beginning Linux users because it is
easy to use and offers a satisfying
experience. It is also a no-nonsense
computing platform for seasoned
Linux users who want a GNOME
environment that makes more
sense.
contents ^
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Pinguy OS comes with userfriendly enhancements and out-ofthe-box support for multimedia
codecs and browser plugins. The
modified GNOME user interface
has enhanced menus, panels and
dock bars. It includes a handpicked
selection of popular desktop
applications for many common
computing tasks.
Pinguy OS may not satisfy
power users who like to control
navigation with keyboard
shortcuts and advanced system
settings. However, if you just want
your system to work from the
start, Pinguy OS has a lot going for
it.
Source:
https://www.linuxinsider.com/stor
y/Pinguy-OS-Puts-On-a-HappierGNOME-3-Face-85439.html

O PTIMIZED CLEAR LINUX
KERNEL N OW AVAILABLE
FOR FEDORA 28 AND
FEDORA RAWHIDE

R

ecent devel list discussion for
popular Linux distro Fedora
mentioned Clear Linux

optimizations, which may be
relevant to Fedora developers in
the future. It was mentioned that
Intel’s Clear Linux show noticeable
performance gains over Xubuntu.

makes any drastic performance
improvements, the potential is
what matters.

Google is already investing in its
1 3th cable project with the Dunant
project. Most of them started
Google together with consortia
Source:
from other companies. With the
https://appuals.com/optimizedproject Curie, which is to connect
It’s interesting for Fedora
clear-linux-kernel-now-availableChile with Los Angeles, Google
developers, as there is a little bit of for-fedora-28-and-fedora-rawhide/ first appeared as a private client.
debate whether or not Clear Linux
Curie is scheduled to finish in 201 9.
kernels actually improve
The private investment also
performance in any significant way, G OOGLE HAS SUBMARINE
applies to Dunant.
or if its entirely negligible. For
CABLES MOVED FROM THE
example, when Phoronix tried a
Source: http://www.linuxClear Linux kernel for Ubuntu, all
US TO EUROPE
magazin.de/news/google-laesstthey managed to achieve was
seekabel-von-den-usa-nachdecreased boot times, but nearly
oogle has hired specialist TE
europa-verlegen/
all other tests showed only
Subcom to relocate a
minuscule gains compared to the
submarine cable from Virginia
stock Ubuntu kernel.
Beach to the French Atlantic coast.

G

Thus, its important to
remember that finely-tuned
kernels are only one small part of
the overall puzzle. There are many
other tweaks involved, particularly
amongst the Intel development
team working on Clear Linux,
where they apply various packages
to the kernel, and some vital
components such as Glibc, GCC,
and compiler optimizations
revolving around LTO, FMV, and
PGO.
Still, whether or not a Clear
Linux kernel for Fedora actually
full circle magazine #1 35

The submarine cable project is
named Dunant, after the Peace
Award winner and founder of the
Red Cross Henry Dunant. The fourfiber cable extends over a length
of 6400 kilometers according to TE
Subcom and is to supply further
capacities to the global Google
network. The Communication also
states that links to other
submarine cables in the region will
be made. The costs for the project
are not mentioned. Google expects
completion by 2020. A submarine
cable has a lifespan between 1 5
and 25 years, Google said.

9

SUSE LAUNCHES NEW
ENTERPRISE LINUX TO HELP
THE MOVE TO SOFTWAREDEFINED INFRASTRUCTURE

B

usinesses are increasingly
running a mix of traditional
and software-defined
architectures and the launch of
SUSE Linux Enterprise 1 5 is aimed
at bridging the gap between the
two.
It's a modular operating system
that helps make traditional IT
infrastructure more efficient and
contents ^
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FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8

provides an engaging platform for
developers. It also aids in
integrating cloud-based platforms
into enterprise systems, merging
containerized development with
traditional development, and
combining legacy applications with
microservices.
This 'mulitmodal' approach
means organizations can easily
deploy and transition businesscritical workloads across onpremise and public cloud
environments. To facilitate this it
uses a common code base to
ensure application mobility.

reducing risk. It's also designed to
integrate into commonly used
modern development
methodologies like DevOps and
CI/CD.
The product portfolio includes
server versions for Intel, ARM and
POWER systems, a server for SAP
applications, desktop and
workstation versions and more.

because it uses a classic WIMP
interface that users love, while also
feeling modern. With Cinnamon
3.8, the Linux Mint Team focused
on improving the DE's
performance, and today, the team
shares that it is continuing that
mission with the upcoming 4.0. In
particular, the team is focusing on
Vsync.

I must say, it is refreshing that
the Linux Mint Team is focusing on
Source:
https://betanews.com/201 8/07/1 9/ performance and "under the hood"
improvements for Cinnamon 4.0.
suse-linux-enterprise-1 5/
Quite frankly, the desktop
environment is already quite
feature complete and a joy to use.
L
INUX M INT DEVELOPERS
No, I am not saying the interface is
Enterprise 1 5 includes ring-YourPLANNING
BIG
C
INNAMON
perfect and the superficial should
Own-Subscription (BYOS) programs
be ignored, but for now, it
to streamline the use of or move to 4.0 IMPROVEMENTS
shouldn't be a priority. The
Amazon Web Services, Google
developers are absolutely on the
Cloud Platform or Microsoft Azure.
inux Mint is one of the most
right track with Cinnamon 4.0.
There's also a custom-tuned kernel
popular Linux-based desktop
for workloads on Microsoft Azure
operating systems for a reason -Source:
to enable faster boot speeds with a it’s really good. By leveraging the
https://betanews.com/201 8/07/20/
decreased memory footprint.
excellent Ubuntu for its base, and
linux-mint-cinnamon-4/
offering a top-notch user
In addition a new Modular+
experience, success is pretty much
architecture makes everything in
a guarantee.
the OS a module. This means SUSE
LATEST N EPTUNE OS 5.4
can deliver product updates and
While the distribution primarily
BRINGS MANY APPLICATION
patches more frequently. The
focuses on two desktop
modular approach lets customers
IMPROVEMENTS AND
environments -- Mate and
install only the features they need, Cinnamon -- the latter is really the BUGFIXES
making planning easier and cutting star of the show. Cinnamon is great
full circle magazine #1 35
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The Debian-based Linux distro
Neptune OS recently announced a
complete update to Neptune OS
V5.4, which brings a large number
of improvements and updates.
For starters, the GUI has been
given a general makeover with a
package named Neptune Dark,
which includes a modified icon
pack called Faenza Dark, which is
made for dark themes in mind.
Hardware support was also
increased by updating to Linux
Kernel 4.1 6.1 6, which should
address some drivers and bugfixes.
Some other notable updates in this
latest version include KDE
Frameworks being updated to
version 5.48, and KDE Applications
updated to version 1 8.04.3.
However, because he new KF5
version is incompatible with Qt 5.7,
the Neptune OS developers
needed to backport its patches to
5.45.
As for software and app
updates, VLC was updated to
version 3.0.3 which should be
generally much faster, with many
bugfixes. Thunderbird 52.9 should
fix issues with encrypted HTMLT
emails, and the new Excalibur

menu is available in its version 2.7,
which fixes bugs regarding to
multiple activities and shifting
around your favourites.
The default window manager
for Plasma, named KWin, was
updated to version 5.1 2.5 which
was adjusted to be compiled
against Qt 5.7 – users should see
verifiable performance
improvements, as well as nicer
screen effects and better overall
hardware support.

D EBIAN -B ASED SLAX 9.5.0
RELEASED, N OW AVAILABLE
ON H ARDWARE-E NCRYPTED
USB KEYS

S

ince it's been rebased on the
Debian GNU/Linux operating
system, Slax saw two releases,
versions 9.3.0 and 9.4.0, which
introduced numerous
enhancements and new features,
including one-click-to-install
launchers, support for various WiFi devices, EXT4 and NTFS support,
and persistent support enabled by
default when booting from USB
flash drives.

LibreOffice was updated to
version 6.0.6, and the Neptune OS
devs fixed an issue with MTP
causing issues when trying to share
files to Android devices over an
With the Slax 9.5.0 release,
MTP connection.
which incorporates all the latest
security patches and software
Finally, Enlightenment 22 was
updates from the Debian
made available in version 0.22.3,
GNU/Linux 9.5 "Stretch" operating
together with Terminology 1 .2.1
system, the developer also
announced the availability of a USB
Source:
flash drive pre-installed with Slax
https://appuals.com/latestand featuring hardware-based AES
neptune-os-5-4-brings-manyencryption, which can be
application-improvements-andpurchased from the official
bugfixes/
website only with Bitcoin.
According to the developer, the
USB device is universally usable
thanks to its hardware-based AES
full circle magazine #1 35
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(Advanced Encryption Standard)
encryption, which is done directly
by the drive itself through keys and
without any software (see the
image below to see it in action).
When removed, the USB stick
automatically locks itself.
So if you manage to purchase
the new encrypted USB key with
Slax pre-installed, you'll be able to
use the tiny Linux-based computer
operating system like it was
designed to be used from the very
beginning, back when it was based
on Slackware instead of Debian
GNU/Linux.
Source:
https://news.softpedia.com/news/
debian-based-slax-9-5-0-releasedwith-usb-key-with-hardware-basedaes-encryption-522072.shtml

CANONICAL FIXES B OOT
FAILURES ON U BUNTU
1 8.04 LTS AND 1 6.04
LTS, U PDATE N OW

A

bout two weeks ago,
Canonical patched a
regression that would lead to boot
failures on some AMD machines
contents ^
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using the Ubuntu 1 4.04 LTS (Trusty
Tahr) operating system series,
which was caused by a microcode
firmware update for AMD
processors that was supposed to
mitigate the well-known Spectre
microprocessor side-channel
security vulnerability.
Earlier this month, on July 2,
Canonical released a Linux kernel
security update for Ubuntu 1 8.04
LTS (Bionic Beaver) users,
addressing a total of six security
vulnerabilities, one of which
introduced a regression also
causing boot failures, though it
doesn't appear to be limited to
AMD processors only, but also to
Intel machines.
As Canonical allows users of
previous Ubuntu LTS (Long Term
Support) versions to use the Linux
kernel of newer Ubuntu LTS
versions, the patch for the said
regression causing boot failures is
also available for Ubuntu 1 6.04.4
LTS (Xenial Xerus) users that have
the HWE (Hardware Enablement)
kernel from Ubuntu 1 8.04 LTS
(Bionic Beaver) installed by
default.
All Ubuntu 1 8.04 LTS and
Ubuntu 1 6.04 LTS users are urged

to update their installations to the
new Linux kernel versions that are
available in the main software
repositories as soon as possible
and reboot their computers after a
successful installation.
Source:
https://news.softpedia.com/news/
canonical-fixes-boot-failures-onubuntu-1 8-04-lts-and-1 6-04-4-ltsupdate-now-522073.shtml

handful of other improvements.
This includes fixes to GPU drivers,
SCSI, NVMA, PCI, PinCTRL, arch
updates to Arc, x86, NDS32,
PowerPC, and also miscellaneous
fixes for header files, VM and FS
noise.

Source:
https://appuals.com/linux-4-1 8-rc6brings-network-and-driver-fixesincluding-32-bit-vm-fallout-fix/

LINUX BOTS ACCOUNT FOR
95 PERCENT OF DD OS

The changelog is pretty massive
with a lot of commits from various ATTACKS AS ATTACKERS
testers and developers, so read
TURN TO THE PAST
through the changelog on the
kernel mailing list if you want a
ybercriminals are delving into
complete overview of what has
the past to launch attacks
been updated.
based on some very old
LINUX 4.1 8-RC6 B RINGS
vulnerabilities according to the
The VM bug in earlier releases
latest report from Kaspersky Lab,
N ETWORK AND D RIVER
was fixed in the last RC, but there and they're using Linux to do it.
was apparently a bit of 32-bit
FIXES I NCLUDING 32-B IT
fallout from the fix, so issues were
VM FALLOUT FIX
In the second quarter of 201 8,
still cropping up in RC5. However,
experts have reported DDoS
the developers are hoping that
inux users can now evaluate
attacks involving a vulnerability in
RC6
has
completely
eliminated
all
the sixth weekly test release of
the Universal Plug-and-Play
of
the
issues.
the Linux 4.1 8 kernel, titled Linux
protocol known since 2001 . Also,
4.1 8-rc6. This release brings a lot
the Kaspersky DDoS Protection
If everything goes according to team observed an attack organized
of networking fixes and resolves
the team’s plan, Linux 4.1 8-rc7 will using a vulnerability in the
some other issues with previous
be the last release candidate,
releases, as the team focuses on
CHARGEN protocol that was
followed
by
Linux
4.1
8.0
a
week
bringing us closer to a stable
described as far back as 1 983.
afterwards on August 5th, and we
kernel release.
could see the actual stable kernel
In the top 1 0 of countries
pushed
out
by
August
1
2th.
Most of the changes in Linux
hosting the most active command
Fingers
crossed!
4.1 8-rc6 revolve around
and control (C&C) servers, the US
networking fixes, but also driver
leads, accounting for almost half
and architecture updates, and a
(45 percent) of all active botnet

C

L
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C&C servers in Q2. Meanwhile,
Vietnam joined the list while Hong
Kong dropped out of the top 1 0.
One of the most popular
methods of monetizing DDoS
attacks remains the targeting of
cryptocurrencies and currency
exchanges. In Q2, Verge
cryptocurrency suffered an attack
on some mining pools over the
course of several hours, resulting
in $35 million XVGs being stolen in
the ensuing confusion.
Gaming platforms continue to
be a target as well, particularly
during eSports tournaments.
According to Kaspersky Lab, DDoS
attacks affect not only game
servers (which is often done to
extort a ransom in return for not
disrupting the competition) but
also the gamers themselves who
connect from their own platforms.
An organized DDoS attack on a
team's key players can easily result
in that team losing and being
eliminated from a tournament.
Cybercriminals use similar tactics
to monetize attacks on channels
streaming broadcasts of video
games. Competition in this
segment is intense, and by using
DDoS attacks, cybercriminals can
interfere with online broadcasts

and, consequently, a streamer's
earnings.
Source:
https://betanews.com/201 8/07/24
/linux-ddos-attacks/

EVERYTHING ABOUT
U BUNTU ’S N EW D EFAULT
THEME “YARU ”

I

f you follow the Ubuntu
development process closely,
you must be knowing about the
Ubuntu Communitheme that has
been under development for some
time. In case you are a person who
doesn’t like this name, here’s a
good news.
Canonical has announced
details regarding the next default
Ubuntu 1 8.1 0 Cosmic Cuttlefish
theme, which is now called Yaru.
This follows the Japanese
influence on Ubuntu’s theme
naming and it means “to do.”
Ubuntu’s last icon theme’s name
Suru also meant “to do,” but in a
casual way.
The Communitheme theme was
going to ship as the default theme
in the Ubuntu 1 8.04 LTS Bionic
full circle magazine #1 35

Beaver. To make it more polished
and user-friendly, the developers
decided to shift the same to the
next release, i.e., Ubuntu 1 8.1 0.

Source:
https://fossbytes.com/ubuntuyaru-theme-new-try/

It is bow based on GNOME
Adwaita theme and is a result of
community collaboration. The
Communitheme had been available
for testing as a snap for quite
some time now, and Canonical had
been getting the feedback.

O RACLE D ATABASE 1 8:
N OW IN DOWNLOADABLE
LINUX FLAVOUR

If you take a quick look at the
Ubuntu desktop running the
theme, you’ll notice the flat design
right away. It makes sense because
flat design elements are trending
these days and they give a cleaner
look. However, to make it less
boring, the designers have mixed it
with the contours and GNOME
shell’s existing elements.

O

racle Database 1 8 is now
available for on-prem
download on Linux, according to a
talkative senior Oracle chap.
Mike Dietrich, Big Red's master
product manager for upgrades and
migrations, said users can
download 1 8.3 from the Oracle
website as a handy 4.3GB .ZIP file.

In addition, database-loving folk
can also get their hands on
Windows client versions (both 32Based on the user feedback,
bit and 64-bit). It's free to use
over the past two months, many
under the terms of the OTN
changes were incorporated in Yaru: licence, but you need to be
the color and shape of buttons was registered on oracle.com.
made brighter and sharper;
window and sidebar colors were
"The download gets you the zip
made warmer; text selection color file but not the rpm. Those may
changed from orange to blue; and take a couple of weeks for
other changes to borders,
unknown reasons," wrote Dietrich.
shadows, colors, transparency,
notifications, etc.
As we reported last year, Oracle
changed its release numbering
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from version number increments
to year-based increments. Hence
Oracle Database 1 8 was previously
known as Oracle Database
1 2.2.0.2. The cash-printing
company (which posted profits of
$1 3.7bn on revenues of $39.8bn in
fiscal year 201 7) has now moved to
a quarterly release cycle.
While its cloud service and
licensing income revenue was up
by 8 per cent year-on-year, its
infamous licensing business saw
revenues dip by 5 per cent. Times
are interesting for Big Red,
especially as its Autonomous
Database product beds into the
market.
Source:
https://www.theregister.co.uk/201
8/07/25/oracle_database_1 8_dow
nloadable/

G OOGLE G LASS I S
B ACK—N OW WITH
ARTIFICIAL I NTELLIGENCE

G

oogle Glass lives—and it’s
getting smarter.

On Tuesday, Israeli software
company Plataine demonstrated a

due to privacy concerns. Instead,
Google relaunched the gadget as a
tool for businesses called Google
Glass Enterprise Edition. Pilot
projects have involved Boeing
workers using Glass on helicopter
production lines, and doctors
Plataine's app points to a future wearing it in the examining room.
where Glass is enhanced with
Source:
artificial intelligence, making it
https://www.wired.com/story/goo
more functional and easy to use.
gle-glass-is-backnow-with-artificialWith clients including GE, Boeing,
intelligence/
and Airbus, Plataine is working to
add image-recognition capabilities
to its app as well.
new app for the face-mounted
gadget. Aimed at manufacturing
workers, it understands spoken
language and offers verbal
responses. Think of an Amazon
Alexa for the factory floor.

The company showed off its
Glass tech at a conference in San
Francisco devoted to Google's
cloud computing business; the app
from Plataine was built using AI
services provided by Google’s
cloud division, and with support
from the search giant. Google is
betting that charging other
companies to tap AI technology
developed for its own use can help
the cloud business draw customers
away from rivals Amazon and
Microsoft.
The session came roughly one
year after Google abandoned its
attempt to sell consumers on Glass
and its eye-level camera and
display, which proved controversial
full circle magazine #1 35
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WEEKLY N EWS

Join our new hosts Wayne
and Joe as they present you
with a short podcast
(<1 0min) with just the news.
No chit-chat. No time
wasting. Just the latest
FOSS/Linux/ Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast
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N o t e wo rt h y Ap p l i c a t i o n s

Written by Lucas Westermann

have been using the lull of the
last month to read up on all the
articles I save, and the videos I’ve
added to my ‘watch later’ list. In
this article, I plan to share some
applications I’ve discovered
through this reading, and a few
general revelations.

CANTATA
I’m the kind of person who
works best with a bit of
background music playing. For the
longest time, my go-to music
player was NCMPCPP and MPD
(Music Player Daemon). However,
in the course of sharing my music
folder between my laptop and
NUC, I decided I needed an
application I could use to rename
files and organize the folder in
general. Enter Cantata. It’s a
graphical front-end for MPD,
meaning I could still use my
playlists and NCMPCPP whenever I
pleased. It also offers the ability to
download album art, find album
information when ripping CDs, and
dynamic playlists. Overall, the
application does way more than I

ever really use, but also does
exactly what I want when it comes
to organizing files.

presentation. However, if you’re
looking for a relatively fast and
easy way to get into Reveal.js (or
just want a quicker alternative to
If you use MPD, and want a
something like Powerpoint or
graphical interface for it, Cantata
Good Slides), then I highly
should be on your short list of
recommend giving this a shot.
applications to try. Not least of all Using Markdown to format and
because it appears to be one of the style the slides is much faster than
few still being actively developed. a typical GUI and mouse approach.

H UGO-REVEAL
Reveal.js is a library for creating
slideshow presentations using
HTML, and is something I’ve used
occasionally. Hugo is a static site
generator I’ve adopted into my
workflow. As such, I was pleasantly
surprised when I discovered an
article (link in Further Reading
below) that covered a theme for
Hugo that puts Reveal.js to good
use. You can essentially turn your
SSG (static site generator) into a
presentation generator. The
resulting static site can then be
hosted almost anywhere you like
(GitHub Pages, Netlify, your own
host, locally, etc). I haven’t yet
looked into the various options,
nor have I tried to theme a
full circle magazine #1 35

running and testing your projects.
While it would be nice to have a
lightweight option as well,
Homestead is a very robust option.
It may be possible to find a Docker
container that also offers similar
features, but the ease of
installation and configuration for
Homestead offsets the benefits of
Docker.

LARAVEL H OMESTEAD

If you are looking to get into
Laravel, I highly recommend you
One of the video series I started start with Homestead and work
from there. If you happen to
watching was “Building
develop on macOS, they have a
SponsorShip” by Adam Wathan
smaller option called Valet.
(one of the creators of Tailwind
CSS), where he livestreams the
process of developing a Laravel
TEST-D RIVEN
app with Tailwind CSS. The series is D EVELOPMENT
an excellent primer on using
Laravel via TDD (test-driven
The video series mentioned
development), and covers some
above also drove home how useful
aspects of Tailwind CSS as well.
test-driven development can be.
This prompted me to install Laravel While I’m no stranger to TDD, my
on my computer myself. At first, I
main experience using it is with
expected it to be as irritating to
things like Exercism, where a set of
install and maintain alongside my
tests are delivered to you and the
other PHP applications as usual.
actual application is what you need
Instead, I discovered that they
to write. I do occasionally write
offer Homestead - a prepared
tests, but never for web
Vagrant virtual container for
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applications when I work in Rails. I
have therefore decided to take
some time to learn at least the
basics of TDD for Rails, Laravel,
and Python in general. This will
cover my 3 main languages, and
should also allow me to discover
the similarities between testing
libraries.

If you’re a new programmer start with TDD as early as possible!
I know this is a topic that
frequently comes up when hiring
new developers. It can also help
you learn the “programmer’s
mindset”. If you’re an experienced
developer, you may have more
trouble rewiring your workflow to
include TDD, but it’s a step that
most programmers should take. I
don’t mean that TDD should be
used for every project - if you’re
writing 1 5 lines of code, you
shouldn’t need to write tests for
this. However, for any larger
project, or project you may be
maintaining for a while, TDD will
pay off quite quickly.

that offers users the ability to take
notes of any sort - to-do lists,
bulleted lists, tables, databases,
etc. It’s been one that I’ve had on
my radar for quite a while (since
Chris Coyier mentioned it on
ShopTalk), but I waited until they
had created an actual Android app.
The web app lacked some features
I required on mobile (such as
notifications for reminders).

If you’re looking for a notetaking application that can do
much more than just bulleted lists,
I highly recommend you give
Notion a shot. If you don’t feel like
creating another account to keep
track of, you can also simply use
Google to log in.

Previously, I’d used Trello
and/or Google Keep for tracking
small notes. For anything larger, I’d
open a google drive document.
Now, I just open Notion and select
the template that’s most suitable
for what I need. For example, I use
their Tasks template to create todo lists similar to Trello (3 columns,
and I move the items between
them according to their status).
You can also assign users to tasks.

https://laravel.com/docs/5.6/home
The above points have already stead - Laravel Homestead
(or will soon) shape how I work and documentation.
organize myself. Hopefully, they
can do the same for you! If any
programmers among my readers
have good suggestions for getting
into TDD, please do let me know!
As always, I can be reached under
lswest34+fcm@gmail.com. I’m also
open to article suggestions,
questions, or comments!

CONCLUSION

N OTION

FURTHER READING
https://forestry.io/blog/harnessthe-power-of-static-to-createpresentations/ - The article on
using Reveal.js with Hugo.
https://youtu.be/NaTcbDbSPu4 The first livestream for “Building
SponsorShip” by Adam Wathan.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

Lastly - the most noteworthy
application of all. A note-taking
one! Notion is a web application
full circle magazine #1 35
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Written by Greg Walters

hen I meet another
programmer for the first
time, the first question that they
usually ask is what languages do I
program in. Their second question
is usually what do I write my code
in. Is it Emacs, VIM, a text editor, or
an IDE. I surprise most
programmers with my answer of
Geany.
One of the things that makes
(and keeps) a programmer
productive is an efficient IDE. Over
the years, I've tried many different

P yt h o n I n T h e R E AL W o rl d - P t . 8 5

IDE applications and code editors,
and I always come back to Geany.
While Geany is not “officially” an
IDE, it does the job, since it allows
you to write code, and call a build
process (for languages like C/C++).

one exception is debugging, which
isn't really that big of an issue for
me.

It’s not flashy at first glance, but
rather stark and bland. But once
you start working with it, the lack
of flashy is not a bad thing. With
one exception, Geany has
everything that a Python
programmer (or most other
programmers) would want. That

Like any modern IDE, Geany has
multiple editor tabs, which makes
it easy to deal with most large
projects. It also has support for
split windows, either side-by-side
or stacked.

full circle magazine #1 35

Let's take a look at Geany in
depth.

need to provide and in what order.
One of the things that I like
most about Geany is the 'symbols'
sidebar.

This makes it very easy for me
to see the definition of a function
that I’m writing a call to, so that I
know all of the parameters that I
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This shows all of the functions
that are in the current program, as
well as the line number on which
they are defined. Again, for me,
this is a fantastic memory aid.
Of course, Geany also has
themes, from dark to light and
pretty much anywhere in between,
with over 30 different themes predefined. These are available as an
add-on package.

line. This works also with multiline
blocks. Since I like to “decorate”
my code with lots of comments, I
set up one that I call ‘box’. When I
use it, Geany puts in:
# ===========================
# _
# ===========================

I can just fill in the blank with
whatever I need at the time.

Of course, since Geany handles
multiple
programming languages,
Another thing that many IDEs
the snippets are language
provide these days is snippet
dependant, so you have to either
support, which are bits of preset
code that can be inserted by typing save the file as a ‘.py’ file before
you can use the snippet feature, or
a keyword and then pressing the
you can use the menu option
<Tab> key. Shown top right is an
Document|Set Filetype|Scripting
example of some of the
Languages|Python source file.
predefined snippets...
So, if you wanted to start a for
loop in Python, all you have to do
is type:
for

...then hit the tab key (before
typing the space after) and you
get:
for i in xrange(_):

...with the cursor inside the parens
waiting for you to flesh out the

Keyboard shortcuts abound
that take care of many of my work
methods. As I’m programming
away, sometimes I decide to add
something that I wasn’t planning
on when I did the original design.
Many times, for example, I decide
in midstream to add a Try|Except
around a block of code. This
requires the existing code to be
indented. A simple <Ctrl>I indents
the block and if I change my mind,
a <Ctrl>U will unindent it.
full circle magazine #1 35

[Python]
utf8=#-*- coding: utf-8 -*-\n# vim:fileencoding=utf-8
for=for i in xrange(%cursor%):\n\t
doc=""" %cursor% """\n
elif=elif %cursor%:\n\t
else=else:\n\t%cursor%
if=if %cursor%:\n\t
from=from %cursor% import \n
main=if __name__ == '__main__':\n\t%cursor%

Commenting blocks of code is just
as simple, using <Ctrl>E which will
both comment and uncomment
the code block.
Another wonderful thing about
Geany is that I can run my code
directly from the Editor by clicking
on the ‘Run’ icon, or by pressing
<F5>. By default, right now, I’ve
got it set to use Python 2.x. If I
want to run under Python 3.x, I
simply use the Build menu options
and select the option I’ve got set
up for using Python 3. Again, many
editors/IDEs allow for this.
Yes, many of the better modern
IDEs have most, if not all, of the
features I’ve outlined here, but I
find that Geany is easier to deploy
them when I need them. Add the
fact that Geany is Free, available
for most operating systems, and is
open source; I can be productive
under whatever environment I’m
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using. Please take all of my
comments as my own opinions and
pertain to only my preferences.
Until next time, have a great
month.

Greg is a retired programmer living

in Central Texas, USA. He has been a
programmer since 1 972 and, in his
spare time, he is an author, amateur
photographer, luthier, fair musician
and a pretty darn good cook. He still
is the owner of RainyDaySolutions, a
consulting company, and he spends
most of his time writing articles for
FCM and tutorials. His website is
www.thedesignatedgeek.xyz
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Written by Elmer Perry

've mentioned in past articles
about developing a coding
system for your mind maps.
Implementing a coding system can
seem like an arduous effort. But
Freeplane allows you to create
styles in your maps. Using styles,
you create the style once and use
it as often as needed. You can take
a few minutes to think about and
create the styles you need for your
coding system of colors and icons.

Once you make the styles, you
select them from a dropdown list
to apply them to the nodes.

THE STYLE EDITOR
The style editor is where you
create the styles. It looks like a
scaled-down version of the main
window. To open the editor
through the menus, select Format
> Manage styles > Edit styles. You

can also use the keyboard shortcut
CTRL + F1 1 .

D EFAULT STYLES
The default template comes
with a set of default styles in 3
categories.

PREDEFINED STYLES
The predefined styles are the
system styles. You can't add to or
delete any of the styles in this list.
You can change the appearance of
the styles:
• Default is the style assigned to
new nodes when not using an
automatic layout.
• Details is the styling for the node
details.
• Attributes are user-defined tags.
I'll explain attributes in a future
article.
• Note is the style for the note popup that shows when you hover over
a node with notes.
• Floating node is the style for any
floating nodes.

U SER D EFINED STYLES
full circle magazine #1 35
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The user defined styles are
where you would add your own
styles. You can add and remove
styles from this list. The default
template has a few styles defined
for you. You can change these or
remove them. The trick is to add
new ones that work in your coding
system.

APPLY LEVEL STYLES
The level styles are a special
group. You can automate the level
styles by selecting one of the
automatic layouts. The first level
style is Root. You can change the
Root style, but you cannot remove
it. The Root is the center node of
all maps. By default, you have 1 1
levels. You can add and remove
levels as fits your needs. You can
change the nodes to fit your
coding system.

M ODIFYING STYLES
To change a style, select the
style and use the tool panel on the
right-hand side of the window. This
panel is the same as the panel in
contents ^
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the main program. You can set the
colors, edge style, and even create
a style with a cloud. The default
floating node has a rectangular
cloud around it. You can add icons
to the styles as well. Open the icon
toolbar by clicking on the sidebar
arrow on the left side of the
window. Or you can open it
through the menus View >
Controls > Icon toolbar. Click an
icon to add it to the selected style.
The display of the styles is a
map itself, but you can't create any
children. You can add and remove
siblings to the user styles and the
level styles. The siblings are not
added in the same way as in the
main window – as detailed below.

ADDING STYLES
When adding a new user
defined style, the style starts as a
copy of an existing style. You can
create a new user defined style
from any of the styles, including
the predefined and the levels.
After selecting the style you want
as your start point, use the menus
Format > Manage styles > New
style from selection. You can also
right-click the style and select New
style from selection. A dialog

prompts you for a name for the
new style. Enter the name and click
the OK button. The new style will
display in the User defined styles
group.
The level styles work a little
differently. When you add a level,
it adds to the end of the levels list.
To add a new level, right-click any
style and select Add level style.
You can add levels through the
menus at Format > Manage styles
> Add level style. When you add a
level by right-clicking, the format
of the right-clicked style is not
copied to the new level. New levels
get the formatting of the default
style.

REMOVE STYLES
You can remove a user defined
style that is no longer needed. Any
nodes the style is applied to will
have the formatting of the style
removed. To remove a user defined
style, right-click the style and
select Remove user defined style.
You can also remove a style by
selecting it and using the menus
Format > Manage styles > Remove
user defined style.
When you remove a level style,
full circle magazine #1 35

Freeplane removes the highest
numbered level. As with the user
defined styles, any nodes the style
is applied to will have the style
formatting removed. To remove a
level style, use the menus Format >
Manage styles > Remove level
style. Or you can right-click any
style and select Remove level
style.
Once you have finished
changing the styles, click on the
checkmark button to save your
settings. If you want to exit the
edit without saving your changes,
click the X button.

APPLYING STYLES TO
N ODES
The easiest way to apply a style
is using the drop-down list on the
main toolbar. The styles display in
the same order as in the style
editor. You can get the same list
using the menus Format > Apply
styles. After selecting the style,
Freeplane applies the style to all
selected nodes. If you select
another style, you remove the
current style and apply the
selected style. It is possible to
apply more than one style through
conditional styles. I will cover
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conditional styles in my next
article.
Using level styles works a little
differently. Level styles are applied
by the node's position on the
branch. To apply level styles, use
the menu Format > Automatic
layout. You can apply the levels to
all nodes by selecting for all nodes.
Apply the levels to all nodes but
the ones at the end by selecting
for all non-leaf nodes. By default,
disabled is selected. Disabled
removes all level style formatting.

O THER STYLE O PTIONS
Sometimes, you will change a
node that has a style applied to it,
and you want to apply those
changes to the style. Use the
menus Format > Manage styles >
Redefine style. This adds the
changes to the style and updates
all nodes with the style. You can
also use the keyboard shortcut ALT
+ R.
At other times, you change a
node and decide you want to
revert back to the formatting of
the style. Use the menus Format >
Manage styles > Remove format to
remove the changes.
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Did you create the best set of
styles ever and want to use it in a
new map? In the new map, use
Format > Manage styles > Copy
map style from... to import the
style from another map. You can
do this with the keyboard shortcut
CTRL + SHIFT + O as well.

system. Next time, I will show you your styles, so you can use them
how to create conditional styles
over and over again.
that allow you to apply more than
one style to a node. I will also show
you how to save a template with all

STYLE EXAMPLE
When I create a map for
brainstorming a writing project, I
end up with list or outline.
Sometimes, I get started but can't
get back to it for days or weeks. To
keep track of where I'm at in the
project, I create a TODO and Done
style.
The TODO style has a light red
background and an empty
checkbox icon. I apply this style to
any sections that are not done. For
the Done style, I apply a light
green background and a checked
checkbox icon. When a section is
complete, I switch the style from
TODO to Done.
Elmer Perry is a technical support

Styles allow you to design your
coding system by creating a style
once and using it many times.
Through the use of styles, you can
develop and change your coding

rep for an international keyless
access company. He enjoys writing,
woodworking, and technology. He
lives in Leicester, NC with his wife.
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Written by John Bijnens

hen you copy data to a
memory stick, and you lose
the stick, your data can be read by
anyone who happens to find it.
When you place data in the cloud,
your data can be read and analyzed
for commercial purposes such as
offering you tailored ads.
The solution is to encrypt your
data. This should be as hassle free
as possible, and be independent of
the operating system and platform
you use – so you don’t have an
excuse not to apply it.

The first thing you need to do is
to add the repository. Open a
terminal window and type the
following commands to add the
repository and to install the
software.
sudo add-apt-repository
ppa:sebastianstenzel/cryptomator
sudo apt-get update
sudo apt-get install
cryptomator

The software package that can
fulfill all these requirements is
Cryptomator. It takes only a few
seconds to install it. It is written in
Java. The latest version at the time
of writing is 1 .3.2. Users of Ubuntu
(and derivatives like Linux Mint)
can install it in either of two ways,
namely by installing a deb package,
or by installing it from a
repository. As the latter allows for
automatic updates, this way will be
described in the remainder of this
article. All examples are taken
from a Linux Mint 1 8.3 Cinnamon
installation.

This will also create a program
icon as an easy way to start the
software.
When you start Cryptomator, a
dialog window appears that allows
you to manage so-called vaults.
In our example, we are going to
store a folder ‘Secrets’ that is
located within the folder
‘Documents’ in a new vault called
‘DemoVault’.

To conclude, you have to
specify a password. The password
may contain a mix of numbers and
letters. An ideal password is a
sentence and not a word. Don’t
Click on the + button to assign a forget it as there is no recovery
new encrypted vault to a particular possible if you do. You can use a
password manager such as
folder.
KeePass2 if necessary.

Then select the folder Secrets
and enter the name DemoVault as
can be seen in the following
picture.
full circle magazine #1 35
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You have now created your first
vault. When you click on the
button “More Options” you can
specify that the vault will be
mounted to the folder
contents ^
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“DemoVault” and that this folder
will be opened automatically (see
picture below). To open it, click on
the button “Unlock Vault”.

option “Copy WebDAV URL”.

Similarly, create a text
document with the name
‘umount_vault.sh’ and enter the
following 2 lines (the line starting
with sudo is one line).
#!/bin/bash
sudo umount
/home/john/Documents/Personal
/DemoVault

Create a text document with
Now you have to make the two
the name ‘mount_vault.sh’ and
Depending on the configuration enter the following 2 lines (the line files executable by issuing the
commands:
of your Linux system, you may or
starting with sudo is one line).
may not experience problems
chmod u+x ./mount_vault.sh
#!/bin/bash
when writing/saving to an
chmod u+x ./umount_vault.sh
unlocked vault. The problems are
sudo mount -t davfs
http://localhost:42427/2BerFJ
caused by the way a webdav
ngQY2v/DemoVault
Now you can use
mount is handled by your Linux
/home/john/Documents/Personal
./mount_vault.sh to mount your
system. The developers of
/DemoVault -o
username=john,rw,uid=john,gid vault after you have unlocked it,
Cryptomator use gvfs to mount a
=john,file_mode=700,dir_mode= and use ./umount_vault.sh to
webdav drive. This can cause
700
unmount it again. After that you
problems on some systems. The
just have to lock it. For the time
solution is to use davfs. You can
Notes:
being this is a workaround for the
install it by opening a terminal
window and typing
http://localhost:42427/2BerFJngQ mount problem on systems that
have problems using gvfs.
Y2v/DemoVault (This is
sudo apt-get install davfs2
yourWebDAV URL)
Cryptomator is free and open
After you’ve done that, you
source.
If you like it, and want to
/home/john/Documents/Personal/
have to uncheck the option
support its development, you can
DemoVault (This is an existing
“Mount Drive”. Now you have to
donate some money on their
figure out what the webdav url is. folder you want to mount the vault website. This way, the developers
to)
Unlock the vault by entering your
know their hard work is
password. Click on the button next
appreciated.
to “Lock Vault” and select the
full circle magazine #1 35
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Written by Mark Crutch

aving looked at the four main
ways of including an SVG file
in a web page, we’re going to start
examining what you can actually
do with SVG files that you can’t
achieve with simple raster
graphics.

way of including an image: by
linking directly to the SVG file. For
this example, we’re going to use
the following simple HTML page,
which just contains a link to our
SVG file in an <img> tag:
<!DOCTYPE html>

<html>
Speaking of simple raster
graphics, that’s the first of our four <head>
<title>SVG in HTML</title>
ways of including an image, and it’s </head>
one that I’m going to dismiss
<body>
immediately. Once you convert
<img
your SVG to a raster graphic, be it a src="square.svg"></img>
</body>
png, jpeg, or gif, it becomes no
</html>
different in capability to a photo
from a digital camera. You can
As for the SVG file, it’s just a
display it in your web page, but
simple square, drawn in Inkscape,
that’s about it. Sure, with modern and centered in a square page.
CSS and JavaScript you can make it
respond to mouse events, and can
use some SVG-style techniques
such as masking, clipping and
(basic) filtering – but none of those
abilities come from the image
itself. Your raster image is
essentially a rectangle that can
only be modified as a single entity,
losing all notion of the individual
objects in your original SVG file.

So let’s move on to the second
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I’m going to wade in and add
some handwritten CSS to this file,
so, for the sake of clarity (not to
mention space), I’ve saved the
image as an Optimized SVG.
Everything I’m going to do would
also work on an Inkscape SVG, but
if you’re not familiar with editing
XML files, it’s probably worth using
optimized files, at least at first, so
that you don’t have a load of extra
elements and namespaces getting
in the way. My optimized file looks
like the codew shown below (with
a few line breaks added for clarity
– they won’t affect the image).
A hand-coded version of this
image could be even smaller –
there would be no need for a <g>

with a transform when the x and y
coordinates of the <rect> could be
adjusted directly. But this is, after
all, an Inkscape column, so I’ll work
with the output it gives me.
With my SVG file created and
saved into the same directory as
the HTML document, loading the
latter into a web browser gives
exactly the result you would
expect: a web page with a square
in it. So far, we haven’t really
gained a lot over using a bitmap.
Yes, technically it retains a better
quality when scaled, and SVG files
are often (though not always)
smaller than their raster
equivalents – but in many cases
those are modest benefits at best.

<svg width="360" height="360"
version="1.1"
viewBox="0 0 95 95"
xmlns="http://www.w3.org/2000/svg">
<g transform="translate(-7.6 -5.2)">
<rect x="29" y="27"
width="53" height="53"
style="color:#000000;fill:#f00;
paint-order:stroke fill markers;
stroke-width:8;stroke:#800000"/>
</g>
</svg>
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But, even when used in an
<img>, there are some things we
can do with an SVG file that can’t
be done with a raster image. Unlike
a raster image, an SVG file can
include its own CSS code. Let’s
begin by making our red square
blue (note, I’ve abbreviated the
<svg> element for space – in
practice the file still contains the
full element from the previous
example). Code is shown top right.

(using hexadecimal RGB syntax for
the color). So, let’s reload the page
and take a look at our…red square.

As you may already know, CSS
stands for “Cascading Style
Sheets”, and it’s the “cascading”
part that has interfered with our
plans. Without going into all the
gory details, it’s possible to have
more than one source of CSS rules
affecting an element, and the
details of the cascade dictate
If you’re not familiar with CSS,
which rule will take precedence
then here’s what we’ve done: first over the others. In almost all cases,
there’s a pair of opening and
if there’s a rule directly placed on
closing <style> elements. The CSS an element using a “style”
code will be held within them. The attribute, that will win. So, in our
CSS code itself consists of a
case, if we just remove the
selector that identifies what
“fill:#f00;” from within the style
element(s) in a page the rules
attribute of the <rect>, the rule
should apply to. In this case we’ve we’ve added to the <style> block
used a simple element selector:
will win instead. This time if we
essentially if you just use the name reload the page… our square is
of an element (in this case “rect”), blue.
the rules will apply to every
instance of that element. As we’ve
only got one <rect> in our file, we
know that the rule won’t
accidentally affect anything else.
After the selector come the
rules, in a block between a pair of
braces (the “{” and “}” characters).
We’ve got only one rule at the
moment: to make the fill blue

<svg ...>
<style>
rect { fill: #00f; }
</style>
<g transform="translate(-7.6 -5.2)">
<rect x="29" y="27"
width="53" height="53"
style="color:#000000;fill:#f00;
paint-order:stroke fill markers;
stroke-width:8;stroke:#800000"/>
</g>
</svg>

That’s all well and good, but so
far we haven’t really achieved
anything that couldn’t have been
done just by drawing a blue square
in the first place. But what we have
done is to move the rule that
governs the color of the square
from the <rect> element (where
we can’t easily override it) to a
separate block of CSS (where we
can). Our options for how to
override it, however, are rather
limited. This is just an image in our
web page, so mouse events aren’t
propagated into the file itself. That
means no color changes on clicks,
or on hovering the mouse over the
image. In fact there’s really only
one thing we can do to modify the
image in this situation: animate.
And that requires more CSS.
To begin with, we have to

full circle magazine #1 35
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expand our existing set of rules to
also include some information
about the animation we want to
use. At a minimum we have to
create a name for the animation
(so that you can have more than
one in a file), and tell it how long
the animation should last. That
means our rect selector now looks
like this:
rect {
fill: #00f;
animation-name:
myAnimation;
animation-duration: 3s;
}

The choice of animation name is
up to you, but it has to match
whatever name you use in the next
section. This is where we define
the keyframes – specific points in
the animation when we set the
values the CSS should take. Here’s
contents ^
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a simple example for animating
the fill from red to blue:
@keyframes myAnimation {
0% { fill: #f00; }
100% { fill: #00f; }
}

The syntax is pretty
straightforward. First we start with
the string “@keyframes” to
indicate that this is a set of
keyframes, followed immediately
by the name we defined earlier.
Then, inside a block of code
between braces, we have
individual entries for each
keyframe.
A keyframe entry is just the
same as any normal block of CSS,
except that the selector is
replaced with a percentage,
representing how far through the
animation this block should apply.
You pretty much always need at
least a block for the start of the
animation (0%) and one for the
end (1 00%), but you can add more
in-between if you want. Because
animations with just two
keyframes are so common, you can
also use the words “from” and “to”
instead of 0% and 1 00%, which
arguably makes the code a little
more readable.

So, taking both of the blocks
above together, we’ve essentially
said “create a set of keyframes
called ‘myAnimation’ and run them
on the <rect> over a period of 3s.
At the start the fill color should be
#f00 (red), at the end it should be
#00f (blue).”
There’s one little caveat to
catch: notice that there’s still a fill
value on the rect CSS block. At the
end of the animation, the “normal”
CSS for the element will kick in, so
if we don’t also make it blue in
there, the fill will change to black.
Sometimes that behaviour is
desirable; you want to change the
style back to the defaults after the
animation has run. But, more
commonly, you want the style at
the end of the animation to
persist.
As an alternative to duplicating
the final rules for the element, we
can make the last style stick by
adding the “animation-fill-mode”
rule to our rect block instead. The
behaviour we’re seeing is
equivalent to setting this to
“none”, but you can also use
“forwards” to make the element
continue using the style from the
last keyframe. There’s also
“backwards” which does the same
full circle magazine #1 35

with the first keyframe for
animations played in reverse, or
“both” which works in either
direction, and is usually the
simplest option to choose.
Animations played in reverse?
Yes, there’s another property that
will let you do that: “animationdirection”. The default value is
“normal” (i.e. your animation plays
forwards from 0% to 1 00%), but
you can also set it to “reverse”
(1 00% to 0%), “alternate” (0% to
1 00% then back to 0%) or
“alternate-reverse” (1 00% to 0%
then back to 1 00%).
Once you’ve decided what
direction(s) your animation should
run in, you might want to also
determine how many times it will
be performed. For that we have
“animation-iteration-count” which
can take the value “infinite” to
make the animation run forever, or
a number – to specify a particular
number of cycles. Note that a
single cycle goes from 0% to 1 00%
(or vice versa), so if you set
“animation-direction” to
“alternate” or “alternate-reverse”,
you’ll need to set the count to 2
rather than 1 to display both
halves of the animation. With
these values, any odd number will
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finish at the end of the animation,
whilst an even number will return
you to the start. This is also why
it’s usually worth setting
“animation-fill-mode” to “both” –
you can then change the animation
count without having to worry
about a sudden change in style,
regardless of whether there are an
odd or even number of cycles.
Let’s put all this together, and
add another keyframe for good
measure. I’ve also thrown in an
“animation-delay” so that there’s a
short pause between the file
loading and the animation starting.
Our <style> block now looks
something like the text shown on
the next page, top right.
So far, we’ve animated only one
property at a time. But because
each keyframe carries a block of
CSS, it’s possible to animate more
than one property on an object.
Here I’ve also animated the stroke
color and width to substantially
change my square over the course
of the animation. The code is
shown on the next page, bottom
right.
The result, captured at 2s (the
length of the delay, just as the
animation starts), 3.5s (halfway
contents ^
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through the animation), and 5s
(the end of the animation), looks
something like this – though,
obviously, the real thing isn’t a
series of three images, but a single
image that transitions through
these three states:

<style>
rect {
animation-name: myAnimation;
animation-duration: 3s;
animation-fill-mode: both;
animation-direction: alternate;
animation-iteration-count: 3;
animation-delay: 2s;
}
@keyframes myAnimation {
0% { fill: #f00; }
50% {fill: purple; }
100% { fill: #00f; }
}
</style>

In practice, the iteration count
of 3 and direction of “alternate”
means that, after a 2s delay, the
square progresses through each of
these states (iteration 1 ), then
back again in the opposite
direction (iteration 2), then finally
through them in order again
(iteration 3). At the end of the
animation the square remains blue
with a thick stroke, due to the
presence of animation-fill-mode:
both.
As you can see, animating an
SVG image allows for possibilities
that aren’t really available with
raster images – at least not in a
high quality way that works on
most browsers. Next time, we’ll
expand on these capabilities to
push our SVG animations even
further.

@keyframes myAnimation {
0% {
fill: #f00;
stroke: #800;
stroke-width: 8;
}
50% {
fill: purple;
stroke: #f00;
stroke-width: 16;
}

}

100% {
fill: #00f;
stroke: #008;
stroke-width: 40;
}

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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Written by S. J. Webb

have a dedicated R program for
processing data. So, I have
downloaded R, and the associated
R-studio for my work laptop. The Rstudio is a GUI interface for R and
is divided into 4 panes. The upper
left is the R program that you can
import from Leafpad. The lower
left is the actual real-time
command-line processing. The
upper right is publishing the rights
for the statistical outputs and
tables for journal abstracts. The
lower right is the produced tables.

“bugs” in the R-code written by my
biostatistician so the app is not
perfect; however it saves time and
removes technician bias in data
processing. Yet it does a great job
of generating the data
spreadsheets for the pressure and
motion data sets needed. An
example spreadsheet below.

Onto gnuplot now.
I read the starting pages on a
rather dry subject: statistics. There
are 2 software developers’
forewords, an ‘about this book’, 1 5
chapters, and an appendix. The
starting paragraphs have
important background and
historical information on Gnuplot.

Yet it does not cover the real story.
I jumped into Chapter 1 , and it is
quite light with a 1 5 page span.
Luckily, Gnuplot is part of the
RPM and Debian repositories. I
changed to root and installed
gnuplot via terminal – which was
an incredibly smooth process. I
searched the menus and did not

R has the capability of creating
a Shiny app which is an online
capability for the R programs that
you use. It is now possible to be
connected to your R programs
using a web browser. The Shiny app
replaces a previous Perl Batch
program. The batch program
required 2 hrs, the Shiny app does
the same amount of work in 20
minutes.
The Shiny app then generates a
pdf of the waveform plots (as seen
in the lower right) and the
associated critical points. The Shiny
app works well, but there are a few
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see an app icon. I rebooted, rightclicked, and launched terminal with
gnuplot. My book is written about
Gnuplot 4.0, not 5.0. I am banking
on the idea that gnuplot is
relatively static and that the
commands are reliable.
Chapter 1 merely reviews the
scope and capabilities of Gnuplot.
It a simple 1 5 pages that goes into
a brief description of commands.
The authors use an example of

planning a morning marathon and
staffing issues. Essentially, it was
attempting to use bimodal
statistics to highlight a need that
there were two surges of
marathon runners: professionals
and amateurs. The staff would
needed to be present at early
start, say 1 0am, then 1 1 am and
1 pm. The professionals would end
at 1 1 am while the amateurs will be
1 pm. Staffing would be heavy at
those times. This chapter ends by

stating that each chapter will treat
the reader as a new user. I believe
the final message is that gnuplot
will “illuminate” the truth found in
statistical data.
SJ Webb is a researcher coordinator.
When he is not working, he enjoys
time with his wife and kids. He
thanks Mike Ferarri for his
mentorship.
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Written by Richard Adams

n order to stay up-to-date on
Linux, you will need to update,
and may opt to upgrade when
major releases occur. You will
probably also want to periodically
update your applications. This
month, we’ll be looking at how to
do these essential maintenance
functions.
Routine updates are handled
through the Software Updater,
which you can find in the Dash, or
use the HUD – Heads-Up Display:

• The Dash is launched by clicking
the Ubuntu wheel icon (first on the
Launcher).
• The HUD can be invoked by
pressing the ALT key on the
keyboard.
Either way, do a search (‘UPD’
will probably be more than
sufficient) and find the Software
Updater (or, do it the hard, but
admittedly more intuitive, way,
and go to the Dash, click A at the
bottom for Applications, click
Installed, then scroll down to
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Software Updater) see bottom left
image.

shows you a list of found updates.
You will probably want to accept
all, but you can uncheck any as
desired (see bottom image).

The Updater will look for
updates in whatever repositories
You will have to authenticate
you have configured (for more on
repositories, see Everyday Ubuntu with your SuperUser, or
in FCM #1 30). Once it completes, it administrative, credentials:
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back in business, but with
whatever new features Canonical
blessed us with in the newest
release.

replacing the string ‘njam synaptic
burgerspace dosbox’ with a list of
the applications you use, with
spaces between each. Save the file.
Then, when ready to reinstall all at
Sometimes the Software
once, open the text editor again,
Updater won’t find or acknowledge highlight the text, and go to Edit –
the available upgrades, but not to Copy. Now open the Terminal and
The Software Updater will then
(This command may remove
fear – the Command-Line can come use Edit – Paste to put the string
start downloading the available
partially installed or broken
to our rescue once more. Go to a
in. Hit ENTER and Linux will start
updates (see above).
applications, so beware.)
Terminal window and type in:
installing the applications without
having to type the ‘sudo apt-get
You can also update through
You may find yourself wanting
sudo
apt-get
upgrades
install’ part repeatedly. Save the
the command-line tool Apt-Get
to upgrade to the shiny new
file as a text file and you can put it
(see more, also in FCM #1 30’s
version of Ubuntu from time to
then
type
in
your
credentials
on a removable media drive and
Everyday Ubuntu column). In this
time, and that is a lot easier than it
and
the
upgrade
should
start
transfer it for use on a newly set
instance, launch the Terminal and
used to be. Click on the Gear icon
downloading
and
installing.
up machine, as well. Thanks to
the command will be:
on the top-right of your screen and
Marc for a handy time-saving tip!
go to System Settings, then click
sudo apt-get update
Software and Updates. Click the
APT-GET REVISITED
Next time : Getting to know the
Updates tab. If the option for
Sudo, remember, is SuperUser
Dash.
‘Notify me of a new Ubuntu
Everyday Ubuntu
DO, used to allow a ‘normal’ user
version’ (at the bottom) is set to
correspondent Marc Grossé, from
to temporarily act as an
I invite feedback on
anything but ‘for any new version’, France, offers an interesting tip on
administrator, or ‘SuperUser’. You change it to just that, ‘for any new using APT-GET: You can
easier/better ways to do things.
may want to get a shirt with a big
Commentary and feedback are
version’. Close and the Software
concatenate multiple arguments
red ‘S’ on it for the times when you Updater should pop up a message after the ‘install’ switch. Marc uses heartily encouraged and
feel like a Super User, not that I
appreciated, at
if a version is available that’s newer this as a way to easily reinstall
would EVER do anything that
than the one you are currently
multiple applications with a single acer1 1 kubuntu@gmail.com.
silly…. Anyway, the ‘apt-get
using. Click ‘Upgrade’ to start the
command when reinstalling Linux
update’ does just what it looks like: in-place upgrade process, then go or installing it on a new machine.
installs updates. You can also use
make a sandwich while you wait to You can open the Linux text editor
apt-get with a ‘-f’ at the end to tell get the shiny new Ubuntu
and type in the following:
Richard 'Flash' Adams spent about
apt-get to ‘fix’ any broken
Astonishing Anteater, or
20 years in corporate IT. He lives in
applications:
sudo apt-get install njam
rural northwest Georgia, USA, with
Spectacular Spider-Monkey, or
synaptic burgerspace dosbox
his adopted 'son', a cockatiel named
whatever Adjective Animal it is this
sudo apt-get -f install
Baby.
go-round. After a while, you’ll be
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Written by UBports Marketing Team

FORMALIZING THE UB PORTS
FOUNDATION
The final steps to become an
official foundation

A

pril 201 7, the UBports
Community took full
responsibility for the development
and maintenance of the Ubuntu
Touch mobile operating system.
This has led to huge growth of the
community. In order to fulfill the
growing needs of the community,
and support the ambition of
sustaining healthy development of
Ubuntu Touch and its ecosystem, a
formal and legal entity, with
proper leadership, would be
necessary. And so, efforts to
create a Foundation began. As we
stand today, approximately one
year later, we’re still moving
ahead, and are already on the final
steps of the long
legal/bureaucratic process for the
setup of the UBports Foundation.
All the paperwork has been
submitted, and we patiently await
the decision of the authorities.

Ubuntu Touch is built by the
community for everybody who
values freedom of choice. Forming
an official Foundation has been a
long-time goal for UBports. We are
getting very close to this goal; we
expect to have the formal UBports
Foundation established in
August/September 201 8.

A BIT OF HISTORY
The idea to create a foundation
evolved over time. We’d like to
shine some light on the history of
the project and involvement of the
UBports structure.

THE B EGINNING
In 201 5, Marius Gripsgård got
an itch; he felt that the Ubuntu
Touch project (at that time
maintained and developed by
Canonical) should be available to
everybody. So he forced himself to
start porting the OS to a “secret
device”. During this period he had
first contact with some interested
sponsors. Not much later UBports
was born.
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developing Ubuntu Touch or Unity
8 - its "phone and convergence
shell". Unity 8 was central to
In November 201 6, at Ubucon – Canonical's efforts to have one
Essen, the project became more
user interface across all devices. At
serious. Marius presented his plans that time, a small group of
to a bigger audience and managed contributors started to explore the
to persuade a sponsor to make
opportunity of restarting the
financial resources available with
development of Ubuntu on the
the aim of establishing a
mobile devices. UBports made its
Foundation. However, the time was first steps and prepared to “fork”
not right to take that step. Ubuntu Ubuntu Touch. As you all know
Touch was still supported and
now, the brand Ubuntu Touch has
developed by Canonical.
seen the light, and, as of today, it is
still called Ubuntu Touch.
A couple of months later, a
team, including Marius, was invited
O PERATING AS THE
to join Canonical at Mobile World
Congress 201 7. From this moment, UB PORTS COMMUNITY
the dream was ignited! We were
Since the UBports community
ready to join forces and figure out
how to move forward with porting took over the full development of
Ubuntu Touch, new steps needed
Ubuntu to the mobile devices.
to follow. In order for UBports to
its full potential, there was
A B OMB D ROP AND A N EW reach
(and still is) the belief that the
STARTING POINT
establishment of an official legal
Foundation would be required to
Not much later, Canonical
maintain the interests of the
dropped some shocking news. In
community.
April 201 7, they announced that
they would no longer be
Jan Sprinz and Ewald Pierre

J OINT FORCES
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took upon themselves the task of
preparing the required documents
and Foundation structure. To do
this correctly, a first visit to an
accountant took place on June
28th, 201 7. On the side, lawyers
took care of the legal
documentation, including laying
out the correct usage of the brand
(logo, name, distinctive marks,
etc...) and finalizing the
Foundation documents. When
requested, an experienced partner
(LibreOffice) helped us out.
Meanwhile the community
behind Ubuntu Touch grew fast.
New sponsors committed
themselves to the project and
UBports transformed into a well
structured group with a current
member count of well over 1 600
people.

FORMALIZING THE UB PORTS
FOUNDATION
The UBports Board of Directors
(BoD) is excited to announce that
UBports has officially sent (June
1 9th, 201 8) her formal request for
approval to the local government
in Berlin. We are proud that the
final steps to become an official
Foundation are now completed

and we expect to have the formal
UBports Foundation established by
August/September. A Foundation
provides the project benefits such
as more structure, and new
funding and merchandising
opportunities.

WE NEED YOUR HELP TO BE
SUCCESSFUL: JOIN THE
PROJECT, AND BE PART OF
THE EXCITEMENT

issues, there are many nontechnical opportunities for your
contribution as well. We can use all
the support we can get to help
make the new Foundation more
efficient and successful. Whatever
set of skills you have, you are very
welcome to become part of our
community!
Explore the opportunities at
https://ubports.com/join-us!

Ubuntu Touch is moving
forward. The operating system
developments are getting closer
and closer to the very important
big release(1 6.04) as well. The first
release candidate was launched a
couple of weeks ago. If you’re
interested in the development of
Ubuntu Touch, learn more about it,
and about the UBports
Community, at www.ubports.com.
Built on respect, enthusiasm,
and diversity, UBports is a
community in which all members
are highly appreciated and
welcome to contribute. There is
always a place to contribute in one
of the foundations' Steering
Committees (SC) or Focus Groups.
Besides challenging technical
full circle magazine #1 35
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M Y S TO RY

P a rt 5

Written by Paolo Pelloni

recap so far. I wrote a
Q uick
program to enter sort

information in Rhythmbox in an
easier way than to do it manually
track by track. I did it to solve a
need, fix something Rhythmbox
wasn’t doing in the way I wanted it,
and also to brush up my
programming skills, learning
Python along the way. Satisfied
with that, I decided that the next
step was try to enhance it.
The program you saw last
month, does what is says on the
tin, but it’s cumbersome – to be
generous. It runs from the not-sofriendly command line, and can
handle only one album at a time. I
wanted therefore to write a
graphical interface on top of it and,
while I was at it, start using a
better IDE.
What is an IDE? It stands for
Integrated Development
Environment (more info at:
https://en.wikipedia.org/wiki/Integ
rated_development_environment).
So far, I used separate tools, well,
actually only one: gnome text
editor. It was my source editor of

choice, simple, efficient, and it has
code color coding. See Illustration
1 for how the code of fixrhy looks
in gedit; note that it automatically
recognises the language!

code and test it without leaving
the editor. There are several ways
of launching the application:
pressing F5, or clicking on Execute
under Build, or using the relative
icon on the toolbar. It’s a simple
A graphical application was
shortcut, but it speeds up
expected to be more complex, so I development when you want to
wanted an environment that also
immediately check your last source
had auto-completion, code folding, code change.
and more sophistication. The only
IDE I knew was Eclipse, very
When you develop graphical
powerful but a tad too much for
applications in Ubuntu (or Linux for
my requirements. I headed off to
that matter), you can leverage
Ubuntu Software Center and
existing libraries and
searched for IDE. I was
environments: probably the two
overwhelmed by the number of
most common are QT and GTK+. I
results – open source; it’s a great
opted for the latter and
world! I decided to refine my
consequently I named the new
query: “IDE Python”. I opted to try application fixrhygtk. The last bit I
Geany and installed it right away
had to work on was how to design
(you can also install it with the
the user interface of the
command: sudo apt install geany). application. I had a choice between
If you decide to try this lightweight coding it from scratch, or use a
IDE, I suggest you check the
tool, and the tool option was the
plugins, there are several of them, preferable. I had no need for lean
and some may be useful for you
code or speed, so why bother
(see Illustration 2). Check
wasting time writing many lines
Illustration 3 for a glimpse of the
just to describe a button in a
Geany editor window.
window, when a tool like Glade
could do it for me? You can check it
With Geany, I could write my
at https://glade.gnome.org/. In a
full circle magazine #1 35
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nutshell, Glade is a visual editor
where you can design your user
interface (windows, dialog boxes,
menus, etc…) on the screen using
your mouse like a drawing
application. When you have
finished the process, you can save
an XML file that can be loaded into
your application, and, from there,
with few lines of code, display your
objects on the screen and interact
with them. Installing Glade is as
easy as Geany, you can search for it
in the Ubuntu Software Center
(soon to be replaced by Gnome
Center) or do it via the commandline with sudo apt install glade.
Before getting into the actual
code (we’ll examine it in the next
issue), I would like to point out two
things. First I had to do some
research to understand the basic
structure of a Python GTK+
application. If you search Google
with these keywords, there are
loads of results and I encourage
you to check some “Hello world”
programs to familiarise yourself
with a basic backbone. You
probably want to understand also
how containers play a role in the
contents ^
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graphical layout of a GTK+
application. For me, the Python
GTK+ 3 Tutorial acted as an
introduction to some concepts,
and also as a reference guide later
on when I was writing code. You
can find it here: http://python-gtk3-tutorial.readthedocs.io/en/
latest/basics.html For me, it was
important to read the
introductions to chapters 2, 3, 5,
20, 21 and 22.

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH - UPDATED FOR 1 6.04!

B

rian Douglass has created a

fantastic app for Ubuntu Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

I NSTALL
Either search for 'full circle' in the
Ubuntu Touch store and click
install, or view the URL below on
your device and click install to be
taken to the store page.

While I was doing my prework, I
realised that it was easier for me
to write a complete standalone
program, using the knowledge I
got from coding fixrhy, rather than
writing a GUI interface that would
use the CLI program to execute the
changes. If I had to change 7
different albums, with the CLI
version I had to run it 7 times and
therefore parse the DB 7 times.
That is not efficient; I could have
amended fixrhy to accept multiple
albums, but that would have been
too much work. Easier to do all the
processing inside the application,
as we are going to see next time.

https://uappexplorer.com/app/
fullcircle.bhdouglass
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H O W-TO

W ri t e F o r F u l l C i rc l e M a g a z i n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

linked to Ubuntu or one of the
• Do not use tables or any type of
many derivatives of Ubuntu
bold or italic formatting.
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES
• There is no word limit for articles,
but be advised that long articles
may be split across several issues.

If you are writing a review,
please follow these guidelines :

• For advice, please refer to the

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

http://bit.ly/fcmwriting

TRANSLATIONS

• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.

Official Full Circle Style Guide :

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)
document.

full circle magazine #1 35

REVIEWS
G AMES/APPLICATIONS

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
36

contents ^

R E VI E W

I

nnn

Written by EriktheUnready

to use.
f you use the terminal often, or
use a tiling window manager, you
The claim about resource usage
may have heard of Noice.
is true, nnn does not even register
on the radar.
Noice is Not Noice, a noicer
fork.
The first time you run nnn, you
immediately know what is going
andmost resource-sensitive (with all on. To exit, simply press q.
From the Reame.md (version:
1 .7.1 ): nnn is probably the fastest

• Home and End do just that.
• To open a file or folder, hit Enter,
or, to go back, press Backspace.
• Need to go to your home folder:
Tilde (~), the same as bash.
• If you need to create a new file or
folder, press n.
• Did you make a mistake? Rename
it with CTRL+r.
• Need to see hidden files, press
the full stop or period key (.).

its capabilities) file browseryou
The only thing missing is how to
have everused. It's extremely
drive
this thing:
TIP: if you need help steering, at
flexible too - integrates with your
•
The
up
/
down
/
left
/
right
arrow
any point press the (?) question
DEandfavourite GUI utilities, works
mark, and q to exit the help.
with the desktop opener, supports keys steer.
bookmarks, has smart navigation
shortcuts, navigate-as-you-type
mode, disk usage analyzermode,
comprehensive file details, and
much more. nnn was initially forked
from noice but is significantly
different today.

There is no Vi funnies here. We
can say nnn is intuitive.
Let's look at some of the more
impressive and useful functions:
• nnn has the ability to bookmark a
spot. If you work in a directory
often, why not bookmark it? It is a
simple as, you guessed it, b. To
head to your bookmarked folder,
hit CTRL+v.
• If you require more detail about a
file, the key is d. You can just press
the d key again to exit the detailed

In Ubuntu nnn is simply
installed with:
sudo apt install nnn

No PPA's to add or anything.
To run nnn, fire up a terminal
window or move to a terminal TTY
full circle magazine #1 35
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view. This is also very handy if the
file name is too long for your
display.
• Should you require details about
the file, say an mp3, where the
bitrate or file permissions are
important, you use a capital D. To
quit this view , hit q.
• While we are on mp3 files, there
is one caveat, nnn is designed to
integrate into your desktop.
Hitting the right arrow or enter
will not open MOC if it is installed.
It will open the default player set
in Ubuntu.
• If you have a lot of files and
would like to see the size of each,
press capital S.
• Lower case s will sort your files
from largest to smallest or with
another press, smallest to largest.
• Do you need a shell in the current
folder? Simply press (!) exclamation
(or pling, or bang, as it is known).
• There are commands that do not
work out of the box, o will do
nothing until you tell it to open
your file manager. By exporting
your environment variables you
can set the defaults, eg: export
NNN_DE_FILE_MANAGER=nautilus
- Now nautilus will open in the
folder where you are when you
press o.
• The e key is the pest and will
open vi as your default editor, not

nano. Not that Vi is bad, but it is
not newbie friendly.
• The r key likewise. That said... It is
configurable! Export your
environment variable and it will be
so!

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

rian Douglass has created a

fantastic app for Touch devices
that will allow you to view current
issues, and back issues, and to
download and view them on your
Ubuntu Touch phone/tablet.

Full speed ahead, Mr. Sulu. nnn
can make your terminal experience
a whole lot easier and speedier. I
do recommend you look at the nnn
man page, as it is one of the better
man pages.

I NSTALL

PRO’S:

Either search for 'full circle' in the
Ubports App store and click install,
or view the URL below on your
device and click install to be taken
to the store page.

• Fast
• Intuitive
• Integrates well with any DE

CONS:

https://uappexplorer.com/app/
fullcircle.bhdouglass

• There may be some setup work
required.
Overall, nnn is very useful,
easily customizable, and a pleasure
to use. I cannot find any faults and
find it invaluable to navigate web
server content folders when you
only have a terminal. I would
definitely recommend this to
anyone using the terminal.
full circle magazine #1 35
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LE TTE RS

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine

FULL CIRCLE 201 8
SURVEY
It's that time of the year
again where we ask what
you think of FCM, Ubuntu,
and Linux.
Some questions are a
requirement, some you can
skip over if not applicable.
Your answers will help
shape Full Circle, so please
use your constructive
criticism. If you don't tell us
what you think, or what
we're doing wrong, then
we won't know.

Survey URL:
http://bit.ly/fcm201 8
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twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
contents ^

Q &A

Compiled byEriktheUnready

Hello FCM readers. When Ronnie
asked me if I would take over the
Q&A, I thought: “sure, we’ve got
TONS of questions and answers
[in my work database]”. Then I
looked in the database.
Technicians are strange
creatures to say the least.
Writing what you did a day after
the fact can make you forget
what you did. This is when their
creative juices start flowing. I will
start off with some humorous
ones, before we get to the
serious stuff.

The new Ubuntu 1 8.04 dock
Q :does
not minimize or

Q

3. Under extensions, turn off
Ubuntu dock.

: Whenever I put in my
password into Ubuntu, it
usually fails and I am sure I am
typing it correctly. It takes me
several tries every time.

A

: Customer is in hospital after
accident and has his laptop on
his chest. When his right arm
reaches over to type on the left
side of the keyboard, to type 1 23,
his forearm brushes the Enter key
on the numeric keypad.

maximize my window.

A

: The "dock" is actually a
favourites bar. You can
remove it by:
1 . Installing gnome tweaks.

A

If you have a Linux question, email it to: questions@fullcirclemagazine.org ,
and Erik will answer them in a future issue. Please include as much
information as you can about your query.

: Open a terminal and type:

sudo apt update

At the prompt, select lightdm

sudo apt install gnomesession-flashback

Reboot

When you log in, click the gear
icon next to "sign in" and select
"GnomeFlashback" before clicking
sign in.

2. Installing the dash to dock
: After installing DNScrypt in
extension from
Ubuntu 1 8.04 and rebooting, I
https://extensions.gnome.org/exte
cannot access the internet.
nsion/307/dash-to-dock/

Q

4. use ctrl+alt+t to open a terminal
and type:
sudo apt install docky

or:

sudo apt install plank

A

: Manually, set your DNS by
opening the settings
application, WiFi, and click the gear
icon next to your network name.
Click on IP4 and turn OFF
automatic DNS. Insert a DNS server
in the provided space. Now click
apply. it should work immediately.

I don't like the Ubuntu 1 8.04
: Gnome is not working for me.
Q :look,
how can I enable fallback Q How can I get Unity back.
like on previous versions.
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sudo apt install ubuntuunity-desktop

A
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: Open your terminal and
type:

Click the gear icon next to sign
in, and select "Unity" before
logging in.
Any idea why, if I have XRDP
Q :installed
on my Raspberry Pi, I
just get a blank screen when I
remote in from Win 1 0?

A

: This seems to be a common
problem, with the forums
suggesting one uses Tiger VNC.
Using Real VNC,
https://www.realvnc.com/en/conn
ect/download/viewer/linux/ the
VNC part works.

I have set up a new server,
Q :using
an SSH key that I

generated via PuTTyGen, and I
created my server using the public
key. When I try to connect using
PuTTy, and including my private
contents ^
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key, I get the error:
Server refused key

A

: Copy and paste the key from
PuTTyGen, do not use the
contents of the public key file.

FEATURED QUESTIONS AT
ASKUBUNTU .

Q

Dropping to a shell.

A

Could someone tell me what's
next?

Q

A

: BIOS setup is very important.
UEFI and Legacy boot is not
I think I need to reboot the server
compatible. Dell Bios is in "Raid on" or apache but it keeps not working.
by default.
Putty keeps dumping me out
and/or the sites are still down.
: I can't find any
documentation on installing
and configuring codeigniter on
ubuntu 1 6.04. Any help would be
appreciated.

A

: Installing Ubuntu 1 8.04 dual
: Please see:
booting with windows 1 0,
https://www.linuxhelp.com/h
connecting to the wireless is pretty
ow-to-install-codeigniter-inslow. The wifi card is a Broadcom
ubuntu/
BCM431 3 802.1 1 bgn wireless
network adapter.

A

: Under software and updates,
select Additional drivers and
install the proprietary Broadcom
driver.
https://askubuntu.com/questions/
1 001 351 /uuid-xxx-does-not-existdropping-to-a-shell

Q

: How to make sftp user not
have access to hidden files?

Q

sudo reboot

Once rebooted, if your sites are
not up, you can try manually
starting Apache with:
sudo service apache2 start

A

Q
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A

: Try typing:

sudo ufw enable

Q

: I would like to know the steps
: After doing an upgrade that
to install Mariadb, Please don't
installs a new kernel version, a say ‘use mySQL’.
reboot is required for the new
kernel to be loaded. You can do
: Type:
this from PuTTY with:

If the service fails to start,
check the Apache error log file in
: Use chown and chmod just
/var/log/apache2/error.log where
like with any other file.
details of any errors encountered
: I’ve been having problems all when will be recorded.
day, with sites going down.
I am using PUTTY on Windows to
: Trying to set up Nginx in
access the server.
: I have an Elementary OS
Ubuntu 1 6.04 from tutorial,
installation on a Dell Optiplex
everything is fine but running the
790. When I move it to my new Dell To update I use:
sudo apt-get update && sudo
command:
Optiplex 990, I get ALERT!
apt-get dist-upgrade
sudo ufw status
UUID=dd53f4a2-d5af-87c8-9b3egives inactive.
eb074a7849fbf does not exist.
Seems to work.

Q

What is wrong?

41

A

sudo apt install mariadbserver

Can anybody explain how do I
Q :check
web request logs on
Ubuntu server with wordpress
running on Apache?

A

: error log files can be found
at:
/var/log/apache2/access.log and
/var/log/apache2/error.log with
Apache

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine
sized hard drives with multimeters
and oscilloscopes, laying cable, to
scaling 3G towers, he's done it.
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U B U N T U G AM E S

C

Wa rcra ft I I I - Pt.2

Written by Oscar Rivera

ontinuing with Warcraft III
from last month, where we
covered how to install it and how
to run it on Ubuntu 1 8.04, this
month we’ll review the actual
game. As stated last month, please
remember that, to launch the
game, you must first type the
following (as a single
line/command) in a terminal:
wine ~/.wine/drive_c/Program\
Files\ \(x86\)/Warcraft\
III/War3.exe -opengl
-nativefullscreen

than a decade old, you have to
accept that the graphics will be
pretty outdated and, by today’s
standards, not that great.
Originally released in 2002,
Warcraft III is the third game from
the Warcraft game series. The
Frozen Throne, an expansion pack,
was released the following year, in
2003. You can buy Warcraft III
directly from Blizzard’s battle.net

shop for $9.99 (if you buy only the
game without the expansion pack).
This game has been such a big hit
over the years that Blizzard is still
actively updating it. The latest
patch (version 1 .29) for Warcraft III
was actually released in April 201 8
which is pretty impressive for a 1 6year-old game. I was lucky enough
to find the Warcraft III Battle Chest
in Amazon for the low price of
$6.99 in new condition. The Battle

If you forget to run the
previous command, it’s basically
impossible to get the game going
(the game might start, but then,
when you select the mission you
want to play, the game will crash).

Chest includes Warcraft III: Reign
of Chaos CD, Warcraft III
Expansion: The Frozen Throne CD,
and two bonus strategy guides
from Brady Games. I was able to
install the game from these CDs.
You might be asking yourself,
why Warcraft III? Certainly there
are newer games to play, right?
And, you’re right. There are
certainly newer games to play, and
we will get back to a newer Linux
release in upcoming articles, but
Warcraft III is an important game in
more ways than one – which is the
reason I’ve decided to install it,
play it and review it.
For those of you who may not
be familiar with the Warcraft game
series, and without getting too
deep talking about the entire
Warcraft series, let me explain the
importance of Warcraft III. In
today’s gaming world, the two
names synonymous with successful
online gaming are DotA 2 & World
of Warcraft. Both of these games
have their roots in Warcraft III. Let
me explain…

Once you get the game running,
it’s a pretty cool game to play. So
far, I’ve been able to play the game
for many hours without any issues.
The game plays pretty smoothly.
To play Warcraft III, you need to
use a mouse and keyboard – it was
designed to be played on a PC.
Being that this game is more
full circle magazine #1 35
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First for the more obvious of
the two: World of Warcraft. The
Warcraft game series goes back
over a decade. The first video
game to be released from this
series was Warcraft: Orcs &
Humans back in 1 996. Then
followed Warcraft II: Tides of
Darkness, and then Warcraft III:
Reign of Chaos was released. Then
in 2004 World of Warcraft was
released.
Now, as far as DotA 2, it may
not be as easy to see the
relationship if you’re not a DotA
gamer, so let me explain. With
Warcraft III, there is a mod
available that allowed for the
original Defense of the Ancients
(DotA) to be developed. Warcraft
III includes a map editor which
allows the player to create custom
maps and custom games. It was
through Warcraft III, and with the
use of the map editor, that Icefrog
developed and released the
original Defense of the Ancients. In
time, Valve (the company behind
the game engine Steam), hired
Icefrog and a few other game
developers, and tasked them with
developing a new game based on
DotA. The end result was DotA 2.
You can still play the original DotA,
but in order to do so, you need to

have Warcraft III installed.

If you’re looking for a little bit
of nostalgia, or maybe you want to
So, as far as the game is
play the game that was the
concerned, it plays like a charm.
stepping block for whatever your
This game has been out for a while, favorite game might be today, you
so you’d expect it to run smooth
won’t regret going through the
with today’s hardware, and it does. hassle of installing a non-Linux
However, due to the fact that
game. Warcraft III is the first game
there are still new updates being
I’ve reviewed here at Full Circle
rolled out for this game, it does
Magazine that required me to
mean that development hasn’t yet install and run WINE, and I’m happy
ceased and because of it, the folks to report back that this endeavor
at WINE are still actively trying to
was a true success. The game was
get the game to run smoothly on
able to play smoothly, without any
Linux. And they’re doing a great
lag or glitches. However, getting
job of it.

the map editor to run in Linux is
another headache that I haven’t
yet submitted myself to suffer, so I
can’t quite comment on how to use
it nor on how to run and play the
original Defense of the Ancients,
but if I ever do, you better bet I’ll
let you know about it in an article
here. Chances are that I won’t, but
you never know.

Oscar graduated from CSUN, is a

musician, game enthusiast and has
been working with Bitcoin and other
alt-coins. You can follow him at:
https://twitter.com/resonant7hand
or email him at:
7bluehand@gmail.com
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U B U N T U G AM E S

Written by Ronnie Tucker

NOTE: All in-game screenshots in
this article (next page) are
Mineclone2. NOT Minecraft.

S

everal issues ago, I took a look
at a free game called Minetest.
It’s based on the ever popular
Minecraft. It’s the same basic
(blocky) look, but it lacks the
gameplay where you’re running
from creepers, zombies, et al. Well,
Minetest now has an add-on called
Mineclone2 which will make
Minetest just like Minecraft
complete with creepers and the
like.

I NSTALLATION

0.4.1 6 as I write this) from:
https://forum.minetest.net/viewto
pic.php?t=1 6407.
The download is a ZIP file. Open
this either by double-clicking it, or
using a right-click and choose
‘open with archive manager’.
Whichever your desktop uses.
Now, in your file manager, look
in your /home directory for a
folder called .minetest. This will
probably be hidden and will need
you to show hidden files. In Ubuntu
this is done using the window
menu (top right), then choosing
‘show hidden files’.

First, you need to install
Minetest. This can be done either
by downloading it from the
Minetest site
(https://www.minetest.net) and
installing it, or, better still, use
your distributions package
manager.
Now that you have Minetest
installed, you need to install
Mineclone2. Download the latest
version (0.39.0 - for Minetest

M a ke M i n etest Li ke M i n ecra ft

Now that you’re in the
.minetest folder, create a folder
called ‘games’. Go in to the
.minetest/games folder.
Drag the Mineclone2 folder
from the archive manager into that
.minetest/games folder.
That’s it! Mineclone2 is now
added to your Minetest.

RUNNING
Now, as normal, start Minetest.
The trick to getting Mineclone2
is to click the two little ‘dirt’ blocks
at the bottom left of the shaded
area.
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That will tell Minetest to use
the Mineclone2 add-on.
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UBUNTU GAMES
N EW G AME
Starting a game in Mineclone2
is just the same as in Minetest. You
choose ‘New’. Give the world a
name and a unique seed. I use
Mapgen v7 as I find the worlds are
more unusual looking. Oh, and
make sure that Mineclone2 is
selected before you click ‘Create’.
Now, choose your game and
click ‘Play Game’.

M INETESTCRAFTCLONE
I think you’ll agree that the
developer of Mineclone2 has done
a fantastic job of making Minetest
look like Minecraft. Yes, there are
things that aren’t in Mineclone2
yet, but it’s a one-man operation,
and it seems to be a case of the
dev continually adding and
tweaking existing add-ons to get it
just right.
All the basic stuff is there;
digging, crafting, animals, enemies,
and repeatedly dying.
Just watch out for the
Creepers. They’re even more lethal
here than in Minecraft!
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P AT R O N S
M ONTHLY PATRONS
201 6 - Present:

Bill Berninghausen
Jack McMahon
Linda P
Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell
Oscar Rivera
Alex Crabtree
Ray Spain
Richard Underwood
Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz
Joe Gulizia
Kevin Raulins
Doug Bruce
Pekka Niemi
Rob Fitzgerald
Brian M Murray
Roy Milner
Brian Bogdan
Scott Mack
Dennis Mack
John Helmers

JT
Elizabeth K. Joseph
Vincent Jobard
Joao Cantinho Lopes
John Andrews

201 7 - Present:

Matt Hopper
Jay Pee
Brian Kelly
J.J. van Kampen

201 8 - Present:

John Helmers
Kevin O'Brien
Kevin Raulins
Carl Andersen
Charles Stewart
Dave Nelson
Brian Bogdan
Dennis Shimer

Thomas A Lawell
Ronald Le Blanc
Luis Eduardo Herman
Glenn Heaton
Peter Swentzel
Alain Mallette
Christophe Caron
Linda Prinsen
Ronald Eike
Anthony Cooper
Louis W Adams Jr
Joseph Tong
Robert G. Wells
Robert Kaspar
Thomas Gambier
Peter Fitzsimons
Terry O'Neill
Brian Kelly

The Patreon page is to help pay the
domain and hosting fees. The yearly
target was quickly reached thanks to
those listed on this page. The money
also helps with the new mailing list that
I set up.
Several people have asked for a PayPal
(single donation) option, so I’ve added a
button to the right side of the website

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a HUGE help.

https://www.patreon.com/
fullcirclemagazine

SINGLE D ONATIONS
201 8:

Yvo Geens
Graig Pearen
Carlo Puglisi
James A Carnrite
John Holman
P G Schmitt
Robert Cannon
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The current site was created thanks to
Lucas Westermann (Mr. Command &
Conquer) who took on the task of
completely rebuilding the site, and
scripts, from scratch, in his own time.

https://paypal.me/ronnietucker
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https://donorbox.org/recurring
-monthly-donation
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Full Circle Team

H O W TO CO N TRI B U TE

Editor - Ronnie Tucker
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 1 2th Aug. 201 8.
Release :
Friday 31 st Aug. 201 8.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://bit.ly/fcmwriting
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:
EPUB Format - Most editions have a link to the epub file

on that issue's download page. If you have any problems
with the epub file, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the RSS
feed: http://fullcirclemagazine.org/feed/podcast

Issuu - You can read Full Circle online via Issuu:

Or, if you're out and about, you can get the Weekly News via
Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-Circle-WeeklyNews-p855064/
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ronnie@fullcirclemagazine.org

http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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